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1. UvOD

Pristup internetu nikada nije bio jednostavniji i pristupacniji nego u danaSnje vrijeme, ali
za pristup sadrzaju sve viSe stranica zahtjeva posjedovanje neke vrste osobnog racuna. Za
otvaranje ra¢una potrebne su odredene informacije poput: imena, prezimena, e-mail adrese u
nekim slucajevima i kontakt broja i adrese prebivalista. Dok su sve te informacije cesto jednake 1
lako pamtljive jedan komad informacije koji je najvazniji je lozinka. Lozinka predstavlja tajnu
kombinaciju slova, brojki i drugih znakova kojima pristupamo svojem e-ra¢unu. KoriStenje iste
lozinke za pristup vise e-racuna predstavlja losu praksu zato Sto ne mozemo znati kolika je razina
sigurnosti pojedine stranice. RjeSenje problema sigurnosti je vrlo jednostavno, koristiti unikatnu
lozinku za pojedinu stranicu. Dok se to rjesenje ¢ini jednostavnim vrlo brzo dolazimo do dva velika

problema: nemogucénosti pamcenja velike koli¢ine razli€itih lozinki i preklapanja medu lozinkama.

Cilj ovoga rada je izraditi uredaj koji bi predstavljao jednostavno rjesenje za prethodno
navedene probleme. Uredaj bi trebao imati sljede¢e moguénosti: generiranje sigurnih i originalnih
lozinki u stvarnom vremenu, spremanje odnosno ponovno generiranje iste lozinke za traZeni e-

racun, automatizirani unos lozinke i povrat svih lozinki u slu¢aju gubitka uredaja.

U idu¢em poglavlju su opisana tri razli¢ita sustava od kojih svaki rjeSava problem
generiranja i spremanja lozinki na svoj jedinstven nacin. Tre¢e poglavlje sadrzi opis koriStenih
tehnologija za ostvarivanje zadatka zadanog ovim radom. Cetvrto poglavlje prikazuje realizaciju
sustava od modela do prototipa. Peto poglavlje pokazuje ispravnost i nacin rada sustava uz

odredene primjere.
1.1. Zadatak zavrSnog rada

Zadatak ovog diplomskog rada je izraditi USB uredaj za generiranje kriptiranih lozinki.
ESP32-S2 uredaj se treba koristiti za generiranje kriptirane lozinke koriStenjem podataka

primljenih s klijentskog uredaja putem sigurne beZi¢ne veze.



2. PREGLED POSTOJECIH RJESENJA

Postoje mnogobrojna programska i sklopovska rjeSenja generiranja i spremanja lozinki. U
nastavku ovog poglavlja ¢u opisati tri takva rjesenja od kojih su prva dva vrlo popularna i razvijena
su od strane velikih kompanija, dok je treée rjeSenje pretezito otvorenog tipa. Kroz ove primjere

¢u takoder pokusati prikazati njihove prednosti 1 nedostatke koje su dovele do ideje za ovaj rad.

2.1. LastPass

LastPass je jedan od najpopularnijih programa za spremanje i generiranje lozinki za
racunala i mobilne uredaje. Ima podrsku za sve vece operativne sustave: Windows, macOS, Linux,
Android 1 10S. Na racunalima se koristi putem proSirenja za web preglednik i automatski
prepoznaje polja za korisni¢ko ime i lozinku te ima moguénost automatskog popunjavanja tih
polja. U slucaju registracije nudi moguénost generiranja nasumicne lozinke koja se potom sprema
u bazu spremljenih lozinki. Spomenuta baza je zasticena pomocu glavne lozinke koja je poznata
samo korisniku, u sluc¢aju gubitka te lozinke korisnik gubi pristup cijeloj bazi. Baza se sinkronizira
na svakom uredaju gdje je instalirana LastPass aplikacija i sve operacije enkripcije i dekripcije se
odvijaju na korisni¢koj strani. Za enkripciju baze LastPass koristi AES-256 enkripciju sa PBKDF2
SHAZ256 i posoljenim hashevima [1].

LastPass««l |Q searchmyvault gt =

All ltems = Q u = sortBy: Folder(az) =

Sl. 2.1. Izgled LastPass sucelja.

LastPass je u operaciji od 2008. godine i od tada je imao mnogobrojne javne proboje
sigurnosti. Najvec¢i problem kod ovakvog servisa je online komponenta, iako su sve lozinke

kriptirane dostupnost tih lozinki putem interneta predstavlja ogromnu slabu to¢ku. Takoder



enkripcija cijele baze se vr§i pomocu jedne lozinke koja se unosi unutar aplikacije i u slucaju

napada ili proboja sigurnosti napada¢ moze dobiti pristup cijeloj korisnickoj bazi.
2.2. YubiKey

YubiKey je uredaj proizveden od strane Yubico tvrtke i sluzi za zastitu pristupa racunalima,
mrezama 1 mreznim servisima koji podrzavaju sljedece standarde: jednokratne lozinke,
kriptografiju i autentifikaciju pomocu javnog kljuca, te U2F (engl. Universal 2nd Factor) i FIDO2
protokole. Uredaj omogucuje korisnicima pristup navedenim servisima serviranjem jednokratne

lozinke ili javnog kljuca generiranog na uredaju putem USB veze [2].

&
%

Sl. 2.2. Izgled YubiKey uredaja.

Problem kod dvofaktorske autentifikacije je Sto ga koristi jako mali skup posluZitelja koje
normalni korisnik upotrebljava, iz tog razloga YubiKey podrZava i spremanje statickih lozinki.
Ovaj tip lozinke se generira na nacin da korisnik sam unese pocetni dio Sifre 1 potom uredaj
nasumicno dodaje slova iz ograni¢enog skupa [3]. Ovaj nacin spremanja lozinke nije pogodan jer
ogranicen skup slova rezultira manjem broju moguc¢ih kombinacija. Takoder lozinke se spremaju

direktno na samom uredaju $to moze predstavljati jednu vrstu ranjivosti u sluaju gubitka uredaja.
2.3. Snopf

Snopf je jednostavan ali u¢inkovit USB alat, slican prethodno spomenutom YubiKey-u,
koji sluzi za generiranje sigurnih i unikatnih lozinki. Uredaj generira lozinke tako da mu se putem
USB veze i korisnickog sucelja posalju odredeni podaci koje on spaja sa 256-bitnom tajnom
spremljenom u memoriji. Potom se taj skup podataka hashira i rezultantni niz nakon koristenja

BASE64 kodiranja predstavlja generiranu $ifru [4].



Sl. 2.3. Izgled Snopf uredaja.

Za razliku od YubiKey uredaja, Snopf se viSe oslanja na generiranje slozenih i stati¢kih
lozinki umjesto koristenja tehnologija privremenih lozinki ili javnih kljuceva iz tog razloga je puno
bolje rjeSenje jer pokriva veci broj slucajeva. Pozitivna strana ovog uredaja nasuprot raznih online
servisa poput LastPass-a je $to se kod njih sve lozinke spremaju na udaljenim serverima, dok
koriStenjem Snopf uredaja lozinka se uvijek generira lokalno na korisnikov zahtjev. Negativna
strana ovog uredaja je moguc¢nost komunikacije s uredajem jedino putem USB veze i posebnog

programa dostupnog samo za Linux operacijski sustav.
2.4. Idejno rjeSenje ovog rada

Analiza prethodnih rjeSenja je potaknula ideju za stvaranjem sustava koji bi mogao
naslijediti sve njihove pozitivne karakteristike i otkloniti negativne. Sustav bi se sastojao od
posebnog dizajniranog sklopovlja i korisni¢kog sucelja. Rad sustava bi prvenstveno trebao biti
orijentiran na sigurnost ali u isto vrijeme jednostavan i brz za koriStenje. Niti jedan sustav se ne
moze smatrati potpuno sigurnim, svakom racunalnom sustavu je najceS¢e najve¢a mana ljudski

element.



3. KORISTENI PROGRAMSKI ALATI I TEHNOLOGIJE

Sustav opisan u ovom radu moze se podijeliti na dva dijela: klijentsku 1 posluziteljsku
stranu. Klijentska strana bi obuhvacala sucelje koje se prikazuje korisniku u obliku Android
aplikacije izradene pomoc¢u Android Studio razvojnog okruzenja. Dok bi posluziteljska strana
predstavljala uredaj na koji se korisnik spaja pomoc¢u navedene aplikacije i izvrSava proces
generiranja lozinke. Uredaj je posebno dizajniran sklop napravljen oko ESP32-S2
mikroupravljaca. Komunikacija izmedu aplikacije i sklopovlja se vrsi putem bezi¢ne veze

koriStenjem HTTPS protokola.
3.1. Android Studio

Android Studio je sluzbeno integrirano razvojno okruzenje za razvoj aplikacija za mobilni
operativni sustav Android ¢ije sucelje mozemo vidjeti na slici 3.1. Dostupan je za Windows,

macOS i Linux operativne sustave.

Sl. 3.1. Izgled Android Studio razvojnog okruzenja.

Objavljen je 2013. godine na Google I/O konferenciji, te je prva stabilna verzija izasla u
2014. godini. 2019. godine Kotlin zamjenjuje Java programski jezik kao Google-ov preferirani
jezik za razvoj Android mobilnih aplikacija unutar Android Studio-a [5]. Kao i ve¢ina drugih
modernih razvojnih okruzenja Android Studio ima moguénosti automatskog prepoznavanja i

ispravljanja gresaka, te popunjavanja dijelova koda Sto uvelike olakSava i ubrzava posao razvoja



aplikacija. Android Studio takoder podrzava razvoj aplikacija ne samo za mobilne uredaje vec i za

pametne satove, televizore, tablete i druge pametne uredaje.
3.2. Arduino

Arduino je naziv za platformu otvorenog tipa koja sluzi za programiranje Arduino
kompatibilnih uredaja. Stvorena je od strane talijanske tvrtke 2005. godine kao alat namijenjen za
studente, koristeci jeftine 8-bitne mikroupravljace. Kroz godine Arduino platforma je postala jedna
od najkoristenijih platformi u svijetu elektronike i ugradbenih sustava. Zbog svoje
dokumentiranosti i Siroke podrSke moze se upotrebljavati za razne projekte, od svakodnevnih
uredaja do kompleksnih znanstvenih instrumenata. Jedna od glavnih sastavnica ove platforme je

njena zajednica koja svakim danom raste i proSiruje njene mogucnosti [6].

@ sketch | Arduino 18,13 - m] x
File Edit Sketch Tools Help

OO0 BBA 2]
=

sketch

oid setup{) { "
put your setup code here, to run once:

SE, Disabled, 4MB (32Mb), Default 4MB with spiffs (1 2MB APPA SN ?IFFS), Non:

Sl. 3.2. Izgled Arduino razvojnog okruzenja.

Za programiranje Arduino kompatibilnih uredaja, odnosno mikroupravljaca, razvijeno je
Arduino integrirano razvojno okruzenje (Arduino IDE) prikazano na slici 3.2. Arduino programski
jezik koriSten unutar Arduino IDE-a baziran je na AVR C programskom jeziku s odredenim
prethodno ugradenim funkcijama za upravljanje sklopovljem. Takoder ga je moguce prosiriti s

raznim C++ bibliotekama.
3.1. Autodesk Eagle

Autodesk Eagle je jedan od najpopularnijih programa za izradu shematskih prikaza i

dizajniranja tiskanih plocica. Nastao je 1988. godine u Njemackoj od strane tvrtke CadSoft



Computer GmbH kao program za DOS operacijski sustav. Prva verzija programa je omogucavala
samo raspodjelu komponenti na tiskanim plocicama, tek s pojavom verzije 2.0 je omoguceno
crtanje shematskih prikaza. 2016. godine Autocad najavljuje kupnju tvrtke CadSoft Computer
GmbH te s uvodom verzije 8.0.0, u 2017. godini, uvodi pretplatnicki tip koriStenja programa.
Postao je popularan upravo zbog svoje jednostavnosti, podrske zajednice 1 najvaznije besplatnog
koriStenja za studente [8]. Danas je Eagle kao samostalni program prestao s dobivanjem novih
verzija i dolazi integriran unutar Autodesk Fusion360 programa koji sluzi za izradu i uredivanje
3D modela. Trenutno je Eagle dostupan za sve vece racunalne operacijske sustave ukljucujudi:

Windows, macOS i Linux.
3.2. ESP32-S2

ESP32-S2 je visoko integrirani, jednoprocesorski Wi-Fi mikroupravlja¢ male snage,
dizajniran da bude siguran i isplativ, s visokim performansama i bogatim skupom ulaznih i izlaznih
jedinica. Dolazi iz linije vrlo popularnih ESP32 mikroupravlja¢a, nasljednika jednako popularnih
ESP8266 mikroupravljaca od tvrtke Espressif. ESP linija mikroupravljaca je postala popularna
prvenstveno zbog svoje cijene i mogucénosti komunikacije 1 spajanja na internet putem WiFi-a.
ESP32-S2 je koriSten u ovome radu upravo zbog toga Sto predstavlja iteraciju ESP32
mikroupravljaca posebno fokusiranog na sigurnost sa znac¢ajkama poput: sigurnog pokretanja
zasnovanog na RSA-3072, AES-XTS-256 enkripciji flash memorije, zaStite privatnog kljuca i
tajne uredaja od pristupa softvera, kriptografskih akceleratora za poboljSanje performansi i zastite

od fizickih napada ubrizgavanjem gresaka [7].

Sl. 3.3. Izgled ESP32-S2 mikroupravljaca.



3.3. HTTPS

HTTPS (engl. HyperText Transfer Protocol Secure) predstavlja proSirenje standardnog
HTTP protokola. Kod HTTPS-a komunikacijski protokol je kriptiran pomoc¢u SSL/TLS protokola,
stoga se nekad zove HTTP putem TLS-a ili HTTP putem SSL-a. Osnovna primjena HTTPS
protokola je ostvarivanje sigurne komunikacije i razmjene podataka putem interneta. Stiti od
napada poput Covjek u sredini (engl. man-in-the-middle) i zbog enkripcije u oba smjera
onemogucava prisluskivanje ili ¢itanje toka podataka. Zbog toga sto HTTPS protokol zahtjeva
digitalni certifikat potpisan od povjerljive trece strane, Sto je povijesno bio skup poduhvat, koristio
se samo u slucajevima gdje je komunikacija trebala biti strogo zaSti¢ena poput servisa gdje se
obavljaju novcane transakcije ili velikim tvrtkama. U danaSnje vrijeme HTTPS je postao

opceprihvaéen i koristi se za veliku ve¢inu javno dostupnih stranica na internetu [9].



4. REALIZACIJA SUSTAVA

Za realizaciju sustava zadanog zadatkom ovog rada potrebno je izraditi posebno dizajniran
sklop baziran na ESP32-S2 mikroupravljacu i programski kod koji ¢e obavljati sve funkcije

potrebne da bi se uspjesno generirala sigurna lozinka.

U sljede¢im poglavljima ¢e biti objasnjen cjelokupni proces izrade navedenog uredaja od

definiranja svih funkcionalnosti do izrade i programiranja prvog prototipa.
4.1. Model sustava

Ovo potpoglavlje ¢e dati detaljan pregled svih funkcionalnosti koje ovaj sustav treba
obavljati. Dijagram koji prikazuje sve dijelove sustava i komunikaciju medu njima je prikazan na
slici 4.1.

Nacin rada sustava se moze podijeliti u sljedecih pet cjelina:

e Unos podataka

¢ Slanje podataka

e Primanje i obrada podataka
e Generiranje lozinke

e Unos lozinke
4.1.1. Unos podataka

Unos podatak podrazumijeva postojanje korisnickog sucelja za unos podataka o e-racunu
izabranog od strane korisnika. Za generaciju sigurne i unikatne lozinke za pojedini e-racun od

korisnika su potrebni sljedeci podaci:

1. Ime posluzitelja (engl. hostname)

2. Korisni¢ko ime (engl. username)
3. Duljina lozinke

4. lteracija

5. Glavni pin

Ime posluzitelja predstavlja oznaku kojom ¢e korisnik mo¢i raspoznati razliCite servise
poput: Facebook, Gmail, Twitter, itd. Korisnicko ime predstavlja ime/nadimak koji je koristen pri
registraciji e-ratuna na odredenom posluzitelju. Ime posluzitelja i korisni¢ko ime predstavljaju

osnovne podatke pomocu kojih ¢e korisnik moci generirati lozinke za razlicite e-racune. Duljina
9



lozinke, kao §to samo ime govori, predstavlja broj/koli¢inu slova, brojki i drugih znakova koji
tvore lozinku. U slucaju gubitka ili krade lozinke jednostavnim povecanjem vrijednosti iteracije
mozemo dobiti potpuno novu i sigurnu lozinku. Glavni pin predstavlja tajni klju¢ koji korisnik
moze, ali ne mora, unijeti za dodatno osiguranje svojih lozinki. Glavni pin uz tajni klju¢ spremljen
na uredaju predstavljaju dva komada informacije koje korisnik mora strogo ¢uvati jer bez njih je

nemoguce ponovno generirati jednake lozinke.

4.1.2. Slanje podataka

Nakon $to je korisnik unio sve potrebne podatke, sljedec¢i korak je dostaviti te podatke na
uredaj. Kao §to je prethodno spomenuto ovaj uredaj je dizajniran oko ESP32-S2 mikroupravljac
upravo zbog svoje moguénosti komuniciranja putem WiFi-a. Korisni¢ka aplikacija koja sluzi

prikupljanju prethodno navedenih podataka mora imati moguénost spajanja na WiFi mrezu.

Posto se radi o informacijama koje nisu kriptirane jer Zelimo imati apstrakciju korisnickog
sucelja od uredaja s razlogom da se omoguci koristenje drugih sucelja bez prethodne razmjene
informacija odnosno postavljanja privatnih klju¢eva. Ovim postupkom smanjujemo moguénost
spajanja uredaja, s razlogom razmjene kljuceva, u nesiguran sustav i mogucnosti komprimiranja
samog uredaja. Iz tog razloga za razmjenu podataka koristimo postojeci i dobro razvijeni HTTPS
protokol koji omogucéava siguran prijenos podataka bez moguénosti njihovog ocitavanja ili

promjene.

4.1.3. Primanje i obrada podataka

Primanje i obrada podataka se vrSe na strani uredaja. Zbog visoke procesorske snage
odabranog mikroupravlja¢a on ima mogucnosti samostalnog pokretanja i odrzavanja privatnog
HTTPS web server. Takoder uredaj moze raditi u AP (engl. access point) na¢inu rada gdje stvara
svoju osobnu privatnu WiFi pristupnu tocku na koju se klijent potom moze spojiti. Nakon spajanja
klijenta s uredajem putem WiFi-a, korisni¢ka aplikacija dobiva pristup spajanju na lokalni HTTPS

server na koji $alje sve prethodno unesene podatke putem sigurne i kriptirane veze.

Podaci na uredaj pristizu u JSON (engl. JavaScript Object Notation) obliku. JSON je
tekstualni format dizajniran za €itljiv i razumljiv prijenos strukture podataka ljudima i strojevima.
Svi podaci unutar njega se spremaju u obliku parova kljuca i vrijednosti (engl. key-value). Nakon
Sto podatci stignu na uredaj vrlo je lako izdvojiti podatke potrebne za generiranje lozinke i podatke

koji opisuju pravila za generiranja.
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4.1.4. Generiranje lozinke

Za generiranje lozinke osim podataka primljenih putem korisni¢kog sucelja, potreban je i
sigurnosni klju¢ spremljen u memoriji uredaja. Sigurnosni kljué¢ predstavlja 256-bitni jedinstveni
niz predstavljen pomoc¢u 32 znaka koje korisnik mora unijeti prilikom programiranja uredaja. Ovaj
skup znakova i glavni pin korisnik bi trebao zapamtiti ili zapisati na sigurno mjesto jer bez njih
korisnik gubi moguénost ponovnog generiranja identi¢nih lozinki. Takoder u slucaju gubitka

uredaja ako korisnik ima pristup sigurnosnom kljucu vrlo lako moze izraditi novi uredaj.

Nakon §to su svi podaci pripremljeni, uredaj spaja sljedece podatke u jedan dugacak niz:
ime posluzitelja, korisnicko ime, glavni pin, iteraciju i sigurnosni klju¢. Uredaj potom uzima taj
niz i primjenjuje kriptografsku hash funkciju SHA512 nad tim podacima. Hash funkcija je bilo
koja funkcija koja moze primiti podatke proizvoljne veli€ine, a kao rezultat dati nit bitova fiksne
veli¢ine. Veli€ina izlaza uvjetovana je funkcijom koja se koristi. Izlaz hash funkcije ¢e uvijek biti
isti za isti ulaz, ako se promijeni i najmanji dio ulaznih podataka izlaz ¢e biti potpuno razli¢it. Ove
funkcije se jo§ nazivaju i jednosmjernima jer se iz izlaza ne moze saznati ulaz (barem ne s
trenutnom procesorskom snagom). Neke od poznatijih i najceS¢e koriStenih hash funkcija su:
SHA256, SHAS512 i MDS5. SHAS12 funkcija koja je koriStena na uredaju stvara izlazni niz duljine
512-bita. Za generiranje lozinke na uredaju je koriStena upravo ova hash funkcija zbog toga sto je
prvenstveno jednosmjerna, ako netko sazna jednu od lozinki ne moze do¢i do ulaznih podataka
niti generirati druge lozinke. Drugo, jer s istim ulazom uvijek dobivamo isti izlaz $to znaci da
lozinke ne moramo spremati nego ih uvijek moZemo iznova generirati u stvarnom vremenu. [
posljednje, da bi generirali lozinku moramo izlazni niz od 512-bita pretvoriti u niz znakova koji
se smiju koristiti za lozinku, §to znaci da ako uzmemo skup od 64 znaka svaki znak se moZe opisati
sa 7-bita. Ako uzmemo 512-bita i podijelimo na 7-bitne odjeljke dobiti ¢emo maksimalnu duljinu
lozinke koju mozemo generirati i koja iznosi 73 znaka. Taj proces se naziva BASE64 kodiranje,
ali u ovome slucaju koristen je prilagoden skup znakova koji se mogu naci na Sto viSe razlicitih

rasporeda tipkovnice.

4.1.5. Unos lozinke

ESP32-S2 osim §to ima moguénost komuniciranja putem WiFi-a moze koristiti i USB vezu
za komuniciranje putem OTG (engl. on-the-go) standarda. USB OTG omogucuje ovom
mikroupravljacu da se drugim prikljucnim uredajima predstavi kao USB host ili obi¢an uredaj i da
mijenja ulogu u bilo kojem trenutku. Ova implementacija je olaksala razvoj ovoga uredaja jer je

omogucila direktno spajanje podatkovnih USB veza na pinove mikroupravljaca bez potrebe za
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dodatnom periferijom. Pri spajanju uredaja na racunalo ili drugi sustav koji omogucuje USB vezu,
uredaj se predstavlja kao HID (engl. human interface device) i moze imitirati unos poput
tipkovnice. Nakon $to je zavrSilo generiranje hash-a ulaznih podataka i sigurnosnog kljuca,
uzimamo generiranu lozinku i potom jedan po jedan znak Saljemo USB vezom pritom imitirajuci

tipkovnicu sve dok ne poSaljemo broj znakova odreden duljinom lozinke.

* hosthame primljeni
* uUsername HTTPS ‘ podaci
e length > +
e jteration tajni kljué
e master pin
SHA512
+
Korisnitka aplikacija | BASEG4
Generirana
e lozinka
Ciljani sustavza | USB
unos lozinke |
Uredaj

Sl. 4.1. Pojednostavljeni blokovski prikaz modela sustava.

4.2. Sklopovsko rjeSenje

U ovome potpoglavlju opisat ¢e se postupak realizacije sklopovskog rjeSenja uredaja
opisanog zadatkom rada. Za izradu sklopa koristit ¢e se program Autodesk Eagle. Prvi korak pri
izradi sklopovskog rjeSenja za ovaj zadatak je izrada shematskog prikaza. Da bi se izradio

shematski prikaz moraju se prvo definirati sve funkcionalnosti koje uredaj mora imati, to su:

e Komuniciranje putem USB veze
e Komuniciranje putem WiFi veze
e Prikaz trenutnog stanja

e Napajanje
12



Nakon S$to su odredene sve funkcionalnosti potrebne za izradu ovog uredaja moze se
krenuti na crtanje shematskog prikaza i odabira komponenti. Prvi korak je odabir pakiranja ESP32-
S2 mikroupravljaca, koji se moze naruciti u obliku modula ili samostalnog ¢ipa. Za prvu verziju
tiskane plocice koriSten je modul zato Sto se tako privremeno izbjegava problem kompleksnijeg
radiofrekvencijskog dizajna jer ovaj mikroupravlja¢ podrzava spajanje na WiFi i da bi ta veza bila
Sto bolja treba se pridrzavati odredenih pravila i smjernica da bi sustav radio najoptimalnije. Za
drugu verziju u cilju smanjenja volumena uredaja koriSten je samo Cip i sve potrebne periferne

komponente za osnovni rad. Oba dizajna su opisana u sljede¢a dva potpoglavlja.

Crtez shematskog prikaza zadnje verzije uredaja se moze pronaci u prilogu 1.

4.2.1. Prvi dizajn

Prvi dizajn uredaja, prikazan na slici 4.2., koristio je ESP32-S2-WROVER modul koji na
sebi osim §to sadrzi ESP32-S2 mikroupravljac i osnovne komponente za normalan i stabilan rad,
sadrzi i antenu. Antena je dizajnirana pomoc¢u to¢no oblikovanog traga bakra na povrsini tiskane
plo¢ice modula. Da bi antena mogla normalno funkcionirati i odasiljati signal ispod nje se ne smiju

nalaziti veée bakrene povrsine, stoga je na tom dijelu ostavljena prazna plocica.

"
™
“
L
N
N
N
~
N
~
~
~
~N
“
Ll
M

Sl. 4.2. 1zgled prvog dizajna uredaja.

Za normalno funkcioniranje opisanog modula potrebno je dovesti 3.3V napajanje i spojiti
jedan 4.7kQ pull-up otpornik na EN nozZicu. Dovodenjem ovog napona postavljamo tu nozicu u

visoko logicko stanje 1 uredaj ¢e se upaliti. Takoder ovo moZemo koristiti za resetiranje uredaja na
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nacin da istu nozicu spojimo preko tipkala na GND, pritiskom tipkala spuStamo nozicu u nisko

logicko stanje i uredaj se gasi.

Za izvor napajanja iskoriStena je prednost dostupnosti USB sucelja Cije je napajanje
standardizirano na 5V i pomocu linearnog regulatora smanjujemo napon na trazenih 3.3V.
Koristeni linearni regulator je AMS1117-3.3 koji dolazi u SOT-223 pakiranju i ima moguénosti
kontinuiranog izlaza 1A struje. Uz njega su postavljena dva 10uF kondenzatora koji otklanjaju

nagle poraste u potro$nji modula.

Uz tipkalo za resetiranje uredaja dodano je jos$ jedno tipkalo koje sluzi za ulazak u nacin
za programiranje uredaja. Jedna strana tipkala je spojena na GND dok je druga spojena na GP1O-
0 nozicu modula koja je preko 4.7kQ otpornika povucena na visoku logi¢ku razinu. Za ulazak u

nacin za programiranje uredaja mora se drzati ovo tipkalo prilikom ponovnog pokretanja.

Komunikacija putem USB veze je ugradena u ESP32-S2 mikroupravlja, stoga za
ostvarivanje komunikacije putem USB-a moguce je direktnim spajanjem podatkovnih veza
konektora sa modulom. Za signalizaciju o stanju uredaja koristene se dvije bijele LE diode.
Takoder je na uredaj dodan i 2.54mm header s tri nozice koji je omogucavao komunikaciju putem

serijske veze za otklanjanje pogreSaka.

4.2.2. Drugi dizajn

Za drugu verziju dizajna uredaja cilj je bio smanjiti cjelokupni volumen. To Se moglo
posti¢i samo prelaskom sa koriStenja modula na koriStenje samostalnog ¢ipa. Razlike izmedu prve

i druge verzije su:

e Zamjena modula sa ¢ipom
e 4-slojna plocica

e Manja antena

e Jedno tipkalo

e RGB LE dioda

Na slici 4.3. se moze vidjeti izgled druge verzije uredaja. Za ostvarenje ovoga cilja
potrebno je bilo pre¢i sa koriStenja dvoslojne ploCice na koriStenje Cetveroslojne zbog ustede
prostora i veli¢ine komponenti. Za razliku od kori$tenja modula, ve¢ina komponenti se morala

koristiti i u ovome novom dizajnu, §to je podrazumijevalo koristenje jako malih komponenti
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veli¢ine i do 0.6x0.3mm. Postavljanje ovakvih komponenti ru¢no je posao koji se mora izvrSavati

pomocu posebnih alata, ali se njihovim koriStenjem podosta Stedi na veli¢ini uredaja.

RE

T

Sl. 4.3. Izgled drugog dizajna uredaja.

Dizajn tiskane plo€ice je morao sadrZavati 4-sloja ne samo radi lakSeg rutiranja vodova
nego i zbog radiofrekvencijskog dijela dizajna, odnosno vodova Kkoji moraju nositi
visokofrekvencijske signale i potrebni su im odredeni karakteristike dizajna poput: debljine i
duljine vodova, udaljenosti izmedu bakra u slojevima i impedancije vodova. Zadnja karakteristika
je pogotovo bila vazna kod dizajniranja antene uredaja ¢ija je impedancija 50Q2, dok je impedancija
na izlazu iz nozice mikroupravljaca (34+j5)Q. Da bi se izjednacile impedancije potrebno je bilo
koristiti -tip mreze koji se u ovome slucaju sastojao od 2 kondenzatora vrijednosti 2.4pF i 3pF,

te jedne zavojnice vrijednosti 2.2nH.

Nakon koristenja prve verzije uredaja zakljuceno je da posto se uredaj napaja putem USB
konektora nije potrebno tipkalo za resetiranje, jer bi se isti efekt ostvario odvajanjem i ponovnim
spajanjem uredaja. Zbog toga je samo ostavljeno jedno tipkalo koje sluzi za korisnicku interakciju,
a ulazak u nacin rada za programiranje je ostvaren putem zadrzavanja tipkala prilikom spajanja

uredaja.

Umjesto koriStenja dvije odvojene LE diode, zamijenjene su sa jednom RGB LE diodom
koja ima mogucnost prikazivanja razli¢itih boja koje ¢e lakse i brze signalizirati korisniku trenutno

stanje uredaja. Dioda koriStena u ovome dizajnu je WS2812B-MINI.
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4.2.3. 3D model uredaja

Autodesk Eagle ima moguénost automatske izrade 3D modela tiskane plocice s
postavljenim komponentama. Za ostvarivanje ovog rezultata svaka komponenta koriStena u
dizajnu tiskane plocice treba imati postavljen 3D model. Vecina proizvodaca uz svoje komponente
izdaje i CAD (engl. Computer Aided Design) modele koji se potom mogu uvesti u Eagle u raznim
formatima poput: stl, obj, step, itd. Moguénost izrade 3D modela moze biti od velike pomo¢i pri

izradi kucista ili odredenih analiza poput analize rasprSivanja topline uredaja.

Sl. 4.4. 3D model uredaja izraden u Fusion360 programu.

4.3. Programsko rjesenje

Programsko rjesenje sklopovlja uz njegov dizajn predstavlja integralni dio ovog rada. Za
pisanje programskog koda koriSteno je Arduino razvojno okruZenje uz odredene otvorene
biblioteke i prosirenja za rad s ESP32 obitelji mikroupravljaca. Po osnovi svaki kod napisan unutar
Arduino razvojnog okruzenja sadrzi dvije osnovne funkcije: setup() i loop(). Kod napisan unutar
setup funkcije se izvrSava samo jednom i to prilikom prvog pokretanja uredaja, dok se kod pisan
unutar funkcije loop pokrece tek nakon izvrsenja setup funkcije i vrti se beskonaéno mnogo puta,

odnosno do prestanka rada uredaja.
Funkcionalnosti opisane modelom sustava koje je potrebno implementirati u kodu su:

e Pokretanje WiFi pristupne tocke

e Pokretanje HTTPS servera i generiranje certifikata
e Upravljanje RGB LE diodom

e Primanje podataka

e Hashiranje

e BASE®64 kodiranje i slanje podataka putem USB veze
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U sljede¢im potpoglavljima ¢e detaljno biti objasnjeni koraci i postupci koje korisnik mora

proci za uspjesno postavljanje i upotrebu uredaja. Koraci pretpostavljaju da korisnik ima pristup:

e uredaju opisanom ovim radom

e racunalu s instaliranom najnovijom verzijom Arduino IDE-a

Programski kod se moze u cijelosti preuzeti s GitHub repozitorija ¢ija se poveznica nalazi u

zakljucku ovog rada.

4.3.1. Priprema Arduino razvojnog okruZenja

Prije pocetka programiranja potrebno je obaviti odredene korake unutar Arduino razvojnog
okruzenja da bi imali moguénost koristenja ESP32-S2 mikroupravljaca i svih njegovih funkcija.

Prvi korak je instalacija podrSske za ESP32 mikroupravljace:

1. Otvoriti Arduino IDE
2. Unutar programa oti¢i pod File -> Preferences
3. Pod Additional Boards Manager URLSs dodati sljede¢i link:

https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package esp32 index.json

4. Nakon dodavanja linka zatvoriti otvorene prozore

5. Oti¢i u Boards Manager koji se nalazi unutar Tools -> Board
6. U trazilicu unijeti esp32 i kliknuti Install (Slika 4.5)

7. Ponovno pokrenuti Arduino IDE

@ Boards Manager *
Type Al | lesp32
esp32 ~

by Espressif Systems

Boards included in this package:

ESP3Z Dev Module, WEMOS LoLin32, WEMOS D1 MINI ESP32.
More Info

2.00 Install

Close

Sl. 4.5. Prikaz Boards Manager ekrana i esp32 paketa koji treba instalirati.
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https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package_esp32_index.json

Nakon §to je uspjeSno dodana podrska za ESP32 mikroupravljace potrebno je dodati i

odredene biblioteke koje pomazu za komunikaciju putem USB veze i upravljanjem HTTPS
servera.

1. Unutar Arduino IDE-a oti¢i na Sketch ->Include Library -> Manage Libraries

2. U trazilicu unijeti: ,,esp32 tinyusb* i instalirati paket prikazan na slici 4.6

@ Library Manager

X
Type Al | Topic | All w | |esp32 ﬁnyusb|
ESP32TinyUSB -
by Dariusz Krempa Version 1.2.4 INSTALLED
USE functions for ESP22-52 This library provides an implementation of tinyusb for the ESP22-52 for Arduino.
More info
Select version Install
v

Close
Sl. 4.6. Prikaz Library Manager ekrana i esp32 tinyusb paketa koji treba instalirati.

3. Ponovno kliknuti na trazilicu i upisati ,,esp32 https server i instalirati paket prikazan na
slici 4.7. koji pored sebe ima oznaku INSTALLED

(o) Library Manager

*
Type Al ~ | Topic |Al ~ | |esp32 https server
ESP32_HTTPS_Server

~
by Frank Hessel Version 1.0.0 INSTALLED

Alternative ESP22 Webserver implementation for the ESP22, supporting HTTPS and HTTP. The library provides TLS support
and simultaneocus connections. It can be used to run an HTTP or HTTPS server, or both in parallel. The server's rescurces are

defined through handler and middlewara functions, giving an easy start to everyone who has worked with frameworks like
Express or Servlets before.
More info

esp32_https_server_compat

by Frank Hessel , Jack Jansen

An Arduine library for an alternative ESP32 HTTP/HTTPS web server implementation This library is 2 wrapper around

esp32_https_server that provides the same API as the default Webserver library.
More info

Install
EthernetWebServer_S5sL

by Khoi Hoang

Simple TLS/SSL Ethernet WebServer, HTTP Client and WebSocket Client library for Teensy, SAM DUE, SAMD21, SAMDS51,
nRF52, ESP32, ESP8266 and RASPBERRY_PI_PICO boards using Ethernet shields W5100, W5200, W5500, ENC28160 or

Close

Sl. 4.7. Prikaz Boards Manager ekrana i esp32 https server paketa koji treba instalirati.
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4. Ponovno kliknuti na trazilicu i upisati ,,adafruit neopixel i instalirati paket prikazan na slici

4.8. koji pored sebe ima oznaku INSTALLED

@ Library Manager *
Type | Topic |All « | | adafruit neopixel
OV ATSTFOTE -
Adafruit_GFX-compatible library for NeoPixel grids Adafruit_GFX-compatible library for NeoPixel grids
More info
Adafruit NeoPixel
by Adafruit Version 1.8.7 INSTALLED
Arduino library for controlling single-wire-based LED pixels and strip. Arduino library for controlling single-wire-based LED
pixels and strip.
More info
Select version Install
Adafruit NeoPXL8
by Adafruit
Arduino library for controlling 8 NeoPixel LED strips using DMA on ATSAMD21, ATSAMDS51 and RP2040 Arduine library for
controlling 8 NeoPixel LED strips using DMA on ATSAMDZ1, ATSAMDS1 and RPZ040
More info
Adafruit TiCoServo v
Close

Sl. 4.8. Prikaz Boards Manager ekrana i esp32 https server paketa koji treba instalirati.

5. Ponovno kliknuti na trazilicu i upisati ,,arduino json* i instalirati paket prikazan na slici 4.9.

koji pored sebe ima oznaku INSTALLED

@ Library Manager X
Type Al ~ | Topic |All v arduinojson|
Arduino_JSON ~

by Arduino Version 0.1.0 INSTALLED
[BETA] Process JSON in your Arduino sketches.
More info

ardubson

by Hugo Arganda
Arduino Library for BSON (Binary JSON) Encode and decode BSON data
More info

ArduinoJson

by Benoit Blanchon Version 6.17.2 INSTALLED

A simple and efficient 350N library for embedded C++. Arduinclson supports «° serialization, « deserialization, v
MessagePack, v fixed allocation, ¥ zero-copy, + streams, " filtering, and more. It is the most popular Arduino library on
GitHub ¥ %% %%, Check out arduinojson.org for @ comprehensive documentation.

More info

Close

Sl. 4.9. Prikaz Boards Manager ekrana i esp32 https server paketa koji treba instalirati.

6. Zatvoriti Library Manager

Nakon zavrSetka prethodnih koraka mozemo krenuti na objasnjavanje napisanog koda.
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4.3.2. Pokretanje WiFi pristupne tocke

Prvi korak za pokretanje uredaja u AP nacinu rada i odasiljanja privatne WiFi pristupne

tocke je dodavanje biblioteke WiFi.h (Slika 4.10.) koja omogucuje pristup tim funkcijama.

#include <WiFi.h>
Sl. 4.10. Dodavanje WiFi.h biblioteke.

Potom moramo definirati ime i lozinku AP-a uredaja $to je prikazano kodom na slici 4.11.

const char* ssid = "PassVault";
const char* password = "123456789";

Sl. 4.11. Deklaracija imena i lozinka AP-a.

Nakon toga mozemo na pocetku setup funkcije pokrenuti AP nacin rada pomocu naredbe
softAP (Slika 4.12.) koja prima dva argumenta: ssid i password koji su prethodno definirani i
postavljeni na svoje odgovarajuce vrijednosti. SOftAP funkcija moze primiti vise od ova dva
osnovna argumenta, neki od drugih su: WiFi kanal, vidljivost SSID-a i maksimalan broj klijenata
koji se moze spojiti.
WiFi.softAP(ssid, password);
Sl. 4.12. Pokretanje WiFi AP-a na uredaju.

4.3.3. Pokretanje HTTPS servera i generiranje certifikata

Nakon §to smo uspjesno pokrenuli WiFi pristupnu to¢ku i omogucili korisniku da se spoji
na uredaj moramo pokrenuti HTTPS web server na koji ¢e se slati korisnicki podaci. Prvi korak je
dodavanje potrebnih biblioteka (Slika 4.13.). Funkcionalnost ovih biblioteka i §to se nalazi unutar
njih nece biti ovdje objasnjene ali o njima se moze vise procitati ovdje [10].

#include <HTTPSServer.hpp>
#include <SSLCert.hpp>

#include <HTTPRequest.hpp>
#include <HTTPResponse.hpp>

Sl. 4.13. Dodavanje biblioteka potrebnih za pokretanje HTTPS servera i generiranje certifikata

HTTPS server dolazi u drugom namespace-u stoga ga je dobro dodati ovdje za lakse
koristenje (Slika 4.14.).

using namespace httpsserver;

Sl. 4.14. Deklaracija HTTPS server namespace-a.
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ESP32 ima moguénost generiranja certifikata na uredaju. To olakSava postupak
namjeStanja uredaja jer ne moramo koristiti druge alate poput OpenSSL-a za generiranje potrebnih
certifikata. Sigurnost generiranih certifikata nam nije problemati¢an jer se korisnik spaja direktno
na uredaj koji ujedno radi kao i posluzitelj i sva komunikacija je jednosmjerna, 0dnosno usmjerena
od korisnika prema uredaju. Na slici 4.15. mozemo vidjeti kod koji sluzi za kreiranje objekta klase
SSLCert koji ¢e sadrzavati informacije o certifikatu i objekta klase HTTPSServer koji ¢e sluziti
za namjestanje sigurnog servera.

SSLCert * cert;
HTTPSServer * secureServer;

Sl. 4.15. Deklaracija pokazivada za objekte klasa SSLCert i HTTPSServer.

Na iducoj slici 4.16. je prikazano instanciranje objekta klase SSLCert.

cert = new SSLCert();
Sl. 4.16. Instanciranje objekta klase SSLCert.

Nakon instanciranja objekta klase SSLCert mozemo generirati certifikat. To ¢emo uciniti
pozivom funkcije createSelfSignedCert (Slika 4.17.) koja prima sljedeée parametre: referencu na
na$ SSLCert objekt, veli¢inu kljuca i niz znakova koji predstavljaju naziv certifikata po x509
specifikacijama. Takoder ¢emo provjeravati je li generacija certifikata prosla uspjesno, tako Sto

¢emo usporedivati povratnu vrijednost funkcije koja treba biti O.

int createCertResult = createSelfSignedCert(
*cert,
KEYSIZE_2048,
"CN=myesp.local,O=acme,C=US");

if (createCertResult != 9) {
Serial.printf("Error generating certificate");
return;

SI. 4.17. Primjer generiranja certifikata.

Nakon §to smo uspjesne generirali certifikat mozemo ga poslati kao argument konstruktoru
klase HTTPSServer da bi dobili njegov objekt (Slika 4.18.).

secureServer = new HTTPSServer(cert);
Sl. 4.18. Instanciranje objekta klase HTTPSServer s ranije generiranim certifikatom.
Nakon S§to smo uspje$no kreirali HTTPSServer objekt moramo definirati rutu naSeg
servera. Zbog toga Sto Saljemo malu koli¢inu podataka i samo za jednu upotrebu koristit ¢emo
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samo jednu rutu. Na slici 4.19. je prikazano postavljanje rute (,,/°) i njene registracije, takoder
odmah poslije toga pokrecemo server i cekamo pomocu While petlje dok server ne bude dostupan.
ResourceNode* nodeEchoPost = new ResourceNode("/", "POST", &handleEcho);
secureServer.registerNode(nodeEchoPost);

secureServer.start();
while (!secureServer.isRunning()) {}

Sl. 4.19. Primjer registracije rute i pokretanja sigurnog servera.

Zadnja naredba koju moramo pokrenuti se pokre¢e unutar loop funkcije i ona sluzi za

omogucavanje servera da prima podatke (Slika 4.20.).

secureServer.loop();

Sl. 4.20. Naredba kojom server ostaje aktivan.

4.3.4. Upravljanje RGB LE diodom

Za signalizaciju korisniku o trenutnom stanju uredaja koristi se jedna RGB LE dioda. Za
koristenje ove LE diode potrebno je dodati biblioteku od kompanije Adafruit pod nazivom
NeoPixel. Takoder moramo definirati objekt klase Adafruit Neopixel koji prima 3 parametra: broj

LE dioda, izlaz mikroupravljaca na koji je spojena i LE diode (Slika 4.21.).
#include <Adafruit NeoPixel.h>

Adafruit_NeoPixel pixels(1, 36, NEO_GRB + NEO_KHZ809);
Sl. 4.21. Dodavanje Adafruit_Neopixel biblioteke i deklaracija pixels objekta.

Na slici 4.22. je prikazan poziv funkcije begin na objektu pixels te nakon njega pozivamo

funkciju setBrightness koja sluzi za postavljanje ja¢ine svjetlosti LE diode, ja¢ina je odredena
brojem od 0-255.

pixels.begin();
pixels.setBrightness(16);

Sl. 4.22. Primjer pokretanja RGB LE diode i postavljanja ja¢ine svjetlosti.

Zaprikaz odredene boje na LE diodi moraju se upotrijebiti dvije funkcije: prva koja odabire
boju i1 druga koja osvjezava LE diodu i prikazuje boju. Za lakSe koristenje napravljena je pomocna
funkcija light, prikazana na slici 4.23., koja sluzi za izvrSavanje obje funkcije odjednom. Funkcija
prima 3 argumenta koja predstavljaju vrijednost 3 boje: crvene, zelene i plave. Vrijednosti su u

rasponu izmedu 0-255.
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void light(int red, int green, int blue) {
pixels.setPixelColor(@, pixels.Color(red, green, blue));
pixels.show();

}
Sl. 4.23. Primjer funkcije koja postavlja boju RGB LE diode.

Uredaj koristi 3 boje za signalizaciju trenutnog stanja:

e Zelena — uredaj je spreman za koriStenje
e Plava — uredaj ¢eka korisni¢ku interakciju

e Crvena — uredaj je u upotrebi

4.3.5. Primanje podataka

Na slici 4.24. je prikazan primjer funkcije handleEcho koja se poziva nakon $to server
primi podatke na prethodno definiranoj ruti. Nakon primitka podataka oni se potom spremaju u
varijablu buffer. Podaci unutar varijable buffer su spremljeni u JSON formatu i moraju se
deserijalizirati prije koriStenja, odnosno spremiti u format razumljiv mikroupravljaéu. Ako se
deserijalizacija izvr$i uspje$no popunjavaju se pojedinacne varijable sa svojim odgovaraju¢im

vrijednostima primljenih od korisnika.

void handleEcho(HTTPRequest* req, HTTPResponse* res) {
res->setHeader("Content-Type", "text/plain");

byte buffer[1024];
char payload[1024];
byte shaResult[64];

while (!(req->requestComplete())) {
size t s = req->readBytes(buffer, 1024);
res->write(buffer, s);

[...]

StaticJsonDocument<1024> doc;
DeserializationError error = deserializeJson(doc, buffer);

if (lerror) {
const char* hostname = doc["hostname"];
const char* account = doc["account"];
bool button = doc["button"];
int len = doc["length"];
const char* iteration = doc["iteration"];
const char* pin = doc["pin"];
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const char* layout = doc["layout"];
[...]
}
}
}

Sl. 4.24. Primjer handleEcho funkcije koja prima podatke poslane na server i primjer spremanja primljenih
podataka.

4.3.6. Hashiranje

Da bismo mogli koristiti hash funkcije na primljenim podacima moramo prvo dodati
biblioteku md.h (slika 4.25.).

#include "mbedtls/md.h"
Sl. 4.25. Dodavanje md.h biblioteke.

Prije nego $to nastavimo s hashiranjem podataka moramo postaviti tajni klju¢ (Slika 4.26.)
koji ostaje spremljen na uredaju i sluzi da bi se ulazni podaci mogli ,,posoliti“. Tajni klju¢ treba

biti duljine 32 znaka odnosno 256-bita.

const char* secret = "WWbYy8hLMaCK2RkWCzBapCXNnXRupLZ3";
Sl. 4.26. Deklaracija tajnog kljuca.

Zbog toga §to zZelimo hashirati sve primljene podatke zajedno sa tajnim klju¢em, moramo
ith prvo spojiti u jedan niz. Varijable iz koda koje ¢e se spojiti 1 potom hashirati su: hostname,
account, pin, interation i secret. One ¢e tvoriti jedinstveni niz iz kojega ¢e se generirati lozinka za
korisnikov traZzeni e-racun. Na slici 4.27. se nalazi navedeni primjer spajanja svih podataka u jednu

varijablu payload i njihovog hashiranja. Hash ¢e potom biti spremljen u varijabli shaResult.

strcpy(payload, hostname);
strcat(payload, account);
strcat(payload, pin);
strcat(payload, iteration);
strcat(payload, secret);

const size t payloadlLength = strlen(payload);

mbedtls md_init(&ctx);

mbedtls md_setup(&ctx, mbedtls md info from type(md_type), 0);

mbedtls _md_starts(&ctx);

mbedtls_md_update(&ctx, (const unsigned char*)payload, payloadLength);
mbedtls md finish(&ctx, shaResult);

mbedtls _md_free(&ctx);

Sl. 4.27. Primjer spajanja vrijednosti varijabli u jedan niz i njihovo hashiranje.
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4.3.1. BASEG64 kodiranje i slanje podataka putem USB veze

Zaslanje podataka, odnosno generirane lozinke, na sustav gdje ju trebamo upisati koristimo
USB sucelje. Za koristenje tog sucelja moramo dodati biblioteke key layout.h i hidkeyboard.h i
deklarirati objekt klase HIDkeyboard koji moramo pokrenuti unutar setup funkcije (Slika 4.28.).

#include "key_ layout.h"
#include "hidkeyboard.h"

HIDkeyboard dev;

void setup() {

[...]

dev.begin();

[...]
¥

Sl. 4.28. Dodavanje key_layout.h i hidkeyboard.h biblioteke, te deklaracija i pokretanje objekta klase HIDkeyboard.

Nakon S§to smo uspjeSno generirali hash svih podataka primljenih na uredaj, moramo
izvrsiti BASE64 kodiranje tog hasha. Postoje gotove funkcije koje bi mogle obaviti ovo kodiranje
ali zbog toga §to nam je bitno koje znakove mozemo dobiti unutar zaporke, napravljen je poseban
algoritam koji ¢e koristiti znakove iz prethodno definiranog polja znakova. Na slici 4.28. je
prikazan primjer prethodno navedenog algoritma koji izvrSava BASE64 kodiranje. Kodiranje se
vr$i tako $to se iz hasha redom uzima svakih 7-bitova koji predstavljaju poziciju znaka koji je
odabran. Nakon §to smo odabrali znak odmah ga prosljedujemo funkciji sendChar koja putem
USB veze $alje znak imitirajudi pritisak tipke na tipkovnici koji pripada tom znaku (Slika 4.29.).
int ¢ = 0;
for (int i =

byte p = 0;
if (1% 4 ==0) {

p = (int)shaResult[c * 3] >> 2;
} else if (i % 4 == 1) {

0; i < len; i++) {

p = (int)shaResult[c * 3] & B11;
p =p << 4;
p =p | ((int)shaResult[c * 3 + 1] >> 4);

} else if (i % 4 == 2) {

p = (int)shaResult[c * 3 + 1] << 2;
p = p & BOA111111;
p=p | ((int)shaResult[c * 3 + 2] >> 6);
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} else if (i % 4 == 3) {
p = (int)shaResult[c * 3 + 2];
p = p & B00111111;
C++;
}
for (int j = @; j < *(&keyLayout + 1) - keyLayout; j++) {
if (!strcmp(keyLayout[j].locale, layout)) {
dev.sendChar(keyLayout[j].charSet[(int)p]);

}

}
delay(25);

Sl. 4.29. Primjer algoritma za BASE64 kodiranje i slanja dobivenih znakova putem USB sudelja.
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5. TESTIRANJE SUSTAVA

Da bi se u potpunosti mogle testirati sve funkcionalnosti ovog sustava izradeno je
priviemeno testno sucelje predstavljeno pomocu mobilne aplikacije napisane u Kotlin
programskom jeziku za Android operativni sustav koristenjem Android Studio razvojnog
okruzenja. Android aplikacija sluzi samo kao prikaz jednog rjeSenja za klijentsko sucelje
dizajniranog sklopovlja jer kljucni dio ovog rada je sam uredaj koji provodi sve operacije za
generiranje sigurne lozinke, dok aplikacija sluzi samo za unos i slanje podataka na uredaj putem
sigurne bezi¢ne veze. Stoga ¢e ovdje biti prikazan samo rad aplikacije, nece biti objasnjen njen

programski kod.

Programski kod Android aplikacije se moze u cijelosti preuzeti s GitHub repozitorija ¢ija

se poveznica nalazi u zaklju¢ku ovog rada.

U nastavku ovog poglavlja ¢e detaljno biti objasnjeni koraci i postupci koje korisnik mora
proci za uspjes$no postavljanje i upotrebu sustava. Koraci pretpostavljaju da korisnik ima pristup

sljede¢em:

e Uredaju opisanom ovim radom
e Mobilnom telefonu s Android 11 operativnim sustavom
e Pristup racunalu s instaliranim Arduino IDE-om verzije 1.8.16 ili novije

e Programskom rjeSenju uredaja
5.1. Programiranje uredaja

Prije programiranja uredaja vazno je proéi kroz korake iz poglavlja 4.3.1. da bi se kod
mogao staviti na mikroupravlja¢ bez pogreSaka. Programiranje uredaja je vrlo lagan proces jer
Arduino IDE podrZzava programiranje ESP32-S2 mikroupravljaca putem USB veze. Za

programiranje uredaja potrebno je pratiti sljedece korake:

1. Otvoriti Arudino IDE i programsko rjesenje uredaja
2. Odabrati ,,ESP32S2 Native USB* iz liste dostupnih razvojnih plo¢a iz izbornika Tools ->
Board -> ESP32 Arduino -> ESP32S2 Native USB (Slika 5.1.)
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Tools Help

Auto Format Ctrl+T
Archive Sketch
Fix Encoding & Reload

Manage Libraries... Ctrl+Shift+]
Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L

WiFi101 / WiFiNINA Firmware Updater

ESP8266 Sketch Data Upload

Board: "Arduine Yin" 3 Boards Manager...

Port 1 Arduino AVR Boards b

Get Board Info ATtiny Microcentrollers >

. . s

Programmer: "Arduine as [SP" ESP32 Arduina ESP32C3 Dev Modul

Burm Bootload ESP8266 Boards (2.7.4) sviodule

urn Beatioader ESP3252 Dev Module
or the server ESP32 Dev Module
P5Server.hpp> ESP32 Wrover Module

Cert.hpp>
PRequest.hpp> ESP32 PICO-D4

PResponse. hpp> ESP3252 Native LISB
N

Sl. 5.1. Prikaz odabira ESP32S2 Native USB uredaja.

Pritisnuti tipkalo na uredaju i drzati ga pritisnutim

Spojiti uredaj na racunalo putem USB sucelja

Pustiti tipkalo

Pod Tools -> Port odabrati spojeni uredaj, u nazivu bi trebao imati ESP32S2 Dev Module
Unutar Arduino IDE-a odabrati Sketch -> Upload

Pricekati da se prijenos programa zavrsi

v »® N kW

Odspojiti uredaj

5.2. Instaliranje Android aplikacije

Android aplikacija koja sluzi za komunikaciju sa sklopovljem se moZe instalirati na dva
nacina: putem Android Studio razvojnog okruzenja ili putem .apk datoteke. Upute za instaliranje
aplikacije putem Android Studio razvojnog okruzenja dostupne su ovdje [11]. Dok instaliranje
aplikacije putem .apk datoteke se vrsi tako da korisnik unutar Android Studio-a pritisne na opciju

Build APK(s), kao Sto je prikazano na slici 5.2.
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Build Run Tools

Make Project

.snopf

Build Bundle(s) / APK(s) Build APK(s)

Generate Signed Bundle / APK... Build Bundle(s)

Sl. 5.2. Prikaz putanje do Build APK(s) opcije.

Nakon $to Android Studio zavrsi s izgradnjom .apk datoteke potrebno ju je prenijeti na
Android uredaj na kojem se Zeli instalirati. Putanja do datoteke unutar glavne mape Android
aplikacije je: android\app\build\outputs\apk\debug\app-debug.apk. Nakon prijenosa na Android

uredaj potrebno ju je pokrenuti i instalirati.
5.3. Koristenje uredaja

Prvi korak pri testiranju uredaja je njegovo spajanje na ciljani sustav putem USB sucelja
gdje hocemo unijeti generiranu lozinku. Na slici 5.3. je prikazan uredaj spojen na jedno od USB
sucelja prijenosnog laptopa. MozZemo primijetiti da uredaj na slici svijetli zelenom bojom Sto

signalizira uspjesno pokretanje AP nacina rada i HTTPS servera.

Sl. 5.3. Prikaz spajanja uredaja.

Uredaj nakon pokretanja osnovnih funkcija ¢eka na spajanje klijentske aplikacije. Prije

pokretanja Android aplikacije potrebno je na mobilnom uredaju oti¢i u postavke bezi¢nih mreza 1
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potraziti pristupnu tocku s nazivom koji je definiran unutar programskog koda prenesenog na
uredaj u poglavlju 5.1. Nakon uspjesnog spajanja na uredaj mozemo otvoriti aplikaciju. Na slici

5.4. mozemo vidjeti izgled ekrana koji se prikazuje prilikom pokretanja aplikacije.

1260 @ B2l D @D

PassVault Accounts Table
Password Settings
Set Master Pin

Info

Save Login

Wait for button press

HR

USE BIOMETRICS

Sl. 5.4. Prikaz pocetnog ekrana Android aplikacije.

Iz prilozene slike mozemo vidjeti polja za unos podataka, opisanih u prethodnim
poglavljima, potrebnih za generiranje lozinke na uredaju. Ti podaci su redom: glavni pin (Master
Pin), ime posluzitelja (Hostname) i korisni¢ko ime (Account). Podaci o duljini lozinke i iteraciji
se mogu pristupiti otvaranjem dodatnog izbornika pritiskom na 3 to¢kice u desnom gornjem kutu

ekrana. Na slici 5.5. je prikazan izgled izbornika za odabir duljine lozinke i iteracije.
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B Sl B @D

Password Settings

Password Iteration

CANCEL (0] ¢

Sl. 5.5. Prikaz izbornika za odabir duljine i iteracije lozinke.

Unutar prethodno spomenutog dodatnog izbornika imamo jo$ dvije opcije: tablica racuna
(Accounts Table) i postavljanje glavnog pina (Set Master Pin). Svaki puta kada pomoc¢u aplikacije
zatrazimo lozinku imamo mogucnost da odaberemo opciju spremanja racuna u tablicu. Ako
odaberemo tu opciju, spremit ¢e se samo sljede¢i podaci: ime posluzitelja, korisni¢ko ime, duljina
zaporke 1 iteracija. Tablica se sprema lokalno na Android uredaju u JSON formatu i moguce ju je
prenijeti na drugi uredaj. U slucaju brisanja aplikacije, brise se i tablica racuna. U tablicu se
spremaju samo novi racuni, ako raun ve¢ postoji unutar tablice nece se dodavati ponovno. Da bi
se zatrazio odredeni racun potrebno je samo kliknuti na njega i svi podaci ¢e se automatski
popuniti. Zadrzavanjem dodira na odredenom racunu dobiti ¢emo mogucénost brisanja odabranog
racuna, §to moramo potvrditi svojim odabirom. Na slici 5.6. mozemo vidjeti izgled liste koja se
generira iz tablice ra¢una. Takoder moZemo vidjeti 1 sko¢ni prozor za potvrdu brisanja odabranog

racuna.
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2228 B 2 Sl @D B 2 Ll B

& PassVault

Are you sure you want to Delete?
test

Sl. 5.6. Prikaz liste ra¢una i moguc¢nosti brisanja pojedinog racuna.

Jedini podatak koji se ne sprema unutar tablice racuna je glavni pin koji je jedinstven i
treba se Cuvati na mjestu kojem se ne moze pristupiti udaljeno. Za spremanje glavnog pina
mozemo Koristiti prethodno navedenu opciju iz dodatnog izbornika. Odabirom opcije spremanja
glavnog pina dobijemo moguénost unosa i spremanja pina pomoc¢u biometrijske zastite. Ova opcija
je dostupna samo na uredajima koji imaju neku vrstu takve zaStite poput: otiska prsta,

prepoznavanja lica ili prepoznavanja Sarenice.

Nakon §to smo unijeli sve potrebne podatke ili odabrali prethodno spremljeni racun na
pocetnom zaslonu, potrebno je pritisnuti tipku ,,OK* ili ,,Use Biometrics* ako smo postavili glavni
pin pomoc¢u biometrijske zastite. Nakon odabira bilo koje od ovih dviju opcija podaci se $alju na
uredaj putem sigurne bezi¢ne veze i u slucaju da smo odabrali opciju ,,Wait for button press“ na
uredaju ¢e LE dioda svijetliti plavom bojom sve dok ne pritisnemo tipkalo uredaja. Ako u
odredenom vremenu ne pritisnemo tipkalo, uredaj ¢e preskociti zahtjev 1 LE dioda ¢e se vratiti u
zelenu boju i éekat Ce se sljedeci poziv. Ako nismo odabrali opciju ,,Wait for button press* ili smo

pritisnuli tipkalo na vrijeme uredaj zapocinje proces dodavanja sigurnog kljuca, hashiranja
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podataka, generiranja lozinke i unosa na ciljani sustav imitirajuci tipkovnicu. Prilikom prijenosa
lozinke LE dioda uredaja svijetli crveno Sto signalizira da je sustav trenutno nedostupan i izvrSava

POSao.

Na kraju testiranja sustava moze se zakljuciti da je uredaj potpuno ispravan i da izvrSava

sve funkcionalnosti prethodno navedene prvenstveno zadatkom, a potom prosirene kroz ovaj rad.
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6. ZAKLJUCAK

U ovom diplomskom radu izraden je sustav za generiranje kriptiranih lozinki pomocu
Android aplikacije i posebnog sklopovlja. KoriStenje sustava omogucuje korisniku da uredaj
prikljuci u drugi sustav gdje mu je potreban unos lozinke, potom pomocu aplikacije unosi trazene
podatke za odredeni e-racun i ti se podaci, poslani uredaju putem sigurne bezi¢ne veze, u stvarnom
vremenu Kriptiraju i iz njih se generira sigurna lozinka. Uredaj nakon generiranja lozinke unosi ju

u prikljuceni sustav na odabrano polje pri tome imitirajuci tipkovnicu.

Prednost ovog sustava je Sto uredaj sam stvara privatnu bezi¢nu pristupnu tocku s
upaljenim HTTPS serverom i zbog toga predstavlja integralni dio ovog sustava, dok se korisni¢ka
aplikacija moze vrlo lagano implementirati na druge operacijske sustave. Za takvu implementaciju

je potrebna moguénost spajanja na bezi¢ne mreze i slanja podataka putem HTTPS protokola.

U svrhe testiranja i1 prikaza rada korisni¢ko sucelje je napisano pomocu Kotlin
programskog jezika unutar Android Studio razvojnog okruzenja. Aplikacija je prilikom razvoja
testirana na najnovijem javno dostupnom Android operativnom sustavu, Android 11. Shematski
prikaz i dizajn tiskane plocCice uredaja su napravljeni unutar programa Autodesk Eagle. Nakon
ispitivanja sustava zakljuceno je da iako sustav zadovoljava sve potrebe navedene u zadatku ovog
rada, postoje mnoga poboljsanja koja bi omogucila lakSe koriStenje i povecala sigurnost uredaja.
Neki od primjera nadogradnje sustava su: automatsko brisanje sigurnosnog kljuca u slucaju krade
ili pokusaja provale, laksi izvoz spremljenih rauna i povecanje sigurnosti pri slanju podataka

putem bezi¢ne veze.
Sve datoteke za izradu uredaja su dostupne na sljedecoj poveznici:

https://github.com/MarinStevic/PassVault
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SAZETAK

U ovom diplomskom radu razvijen je sustav sigurnog generiranja kriptiranih lozinki.
Sustav se sastoji od Android mobilne aplikacije i posebno dizajniranog sklopovlja. Kada korisnik
hoce zatraziti odredenu lozinku ili generirati novu, u aplikaciju unosi sljedece podatke: ime
posluzitelja, korisni¢ko ime, duljinu lozinke, iteraciju i glavni pin. Ti podaci se $alju na uredaj
putem sigurne HTTPS veze, uredaj pomocu primljenih podataka i tajnog kljuca spremljenog u
svojoj memoriji generira sigurnu lozinku i prenosi ju na spojeni uredaj putem USB veze. Korisnik
s unosom istih podataka ¢e uvijek dobiti istu lozinku, ali s najmanjom promjenom ¢e se generirati
nova lozinka. Ovaj sustav ne rjeSava sve probleme oko sigurnosti korisnic¢kih lozinki ali se moze

koristiti kao osnova za daljnji napredak.

Kljuéne rije¢i: Android, Arduino, generiranje lozinki, kriptiranje, sigurnost
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ABSTRACT

Title: Device for generating encrypted passwords

In this thesis, a system for securely generating encrypted passwords has been developed.
The system consists of an Android mobile application and a specially designed circuit. When a
user wants to request a specific password or generate a new one, he enters the following data in
the application: hostname, username, password length, iteration, and master pin. This data is sent
to the device via a secure HTTPS connection, the device generates a secure password using the
received data and the secret key stored in its memory and transfers it to the connected device via
USB connection. A user will always receive the same password with the same input data, but with
the slightest change a new password will be generated. This system does not solve all the problems
around user password security, but it can be used as a basis for further progress.

Key words: Android, Arduino, encryption, password generation, security
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